' Computer Part-6

Chapter-1 Introduction of Computers

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick () the correct option:
a) 1ii) Integrated Circuits
b) 1) Five
c) 1) age
3. Fillin the blanks:
a) Faster b) Speed c¢) Tired
d) Set
4. Answer the following question:
a) Two features of first generation computer
are:

1)  Theyuse vacuum tubes.

i1) They were expensive.

b) Two features of third generation computer
are:

1)  Theyused Integrated circuits.

i1) They were smaller in size than second
generation computers and also less
expensive.

c¢) Two features of Fifth generation computer
are:

1)  They use artificial intelligence for
working.

i1)  They are able to think and take decision
like human beings.

d)  The main characteristics of a computer are:

1)  Acomputer is accurate and a very speed
machine.

i1) A computer works tirelessly and
continuously for a very long time.

iii) A computer has very strong memory.

iv) A computer carries out a number of
different tasks. So, it i1s a versatile
machine.

e) Three differences between third generation

and fourth generation computer are:
1)  Third generation computers used
Integrated circuits while fourth generation
computers used microprocessor.

ii)  Third generation computer were faster
and less expensive. While fourth
generation computers were faster and
cheaper than third generation computer.

ii1) Examples of third generation
computers are: IBM 360, VAX - 750.
ICL 1900. Examples of fourth
generation computers are. IBM 4300,
HP 9000, ICL2900.

Lab Activity:
Do ityourself

Chapter-2 More About Windows 7

Oral Skills

1. Doityourself

Writing Skills

Multiple Choice Questions:

2. Tick (¥) the correct option:
a) 1) Left b) i)  Automatically
c) i) Audio d) i) Copy

3. Fillin the blanks:
a) Now b) First c) Player
d) Document

4. Answer the following question:
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a)

Ripping : The process of copying songs
from audio CD to our computer
in windows media player is
called ripping. During ripping
process, the player makes a
copy of every songs. Stores it
on our hard disk as a window
media Audio (WMA). MP3, or
WAV file, and then adds it to our
player Library.

To burna CD is to copy data
from our computer to a CD. To
do this, we should have a CD
burner / writer linked to or
installed in our computer. We
may use either a blank CD-Ror
CD-Rw disc for burning the
Cds, but not all CD players can
play CD-Rwdiscs.

Burning :



b)

d)

The advantages of minimizing, restarting and

closing the windows are:

1)  When we minimize a window, it looks
live a button on the Taskbar. A
minimized button may be restored by
clicking its preview on the Taskbar.

i1)  We may also minimize a window by
pressing windows logo key + Down
Arrow key.

The Taskbar is the long horizontal bar at the

bottom of our screen. It is almost visible

always. If consists of three main sections.

1) The start button, which opens the start
menu.

i1)  The middle section, which shows us the
programs and files we have opened and
permit us to switch between them
quickly.

ii1) The notification area, which comprises
of icons of a clock (small pictures) that
communicate the status of same
programs and computer setting.

i)  Sheet down means to turn off your
computer.

i1) Sleep is a power saving state that
permits a computer to instantly resume
full-power operation in seconds.

ii1) Hibernation is a power-saving state
developed primarily for laptops while
sleep mode put our work and setting in
memory and draws a small amount of
power, hibernation mode puts then
turns off our computer.

The characteristics of window 7 are:

i) Homegroup : Earlier setting up
network was to take
the frustrations and
pain of its operating
up network. Setup a
home group and
then add PCS and
other devices and
without further a do
we may share files,
printers, etc.

ii) Jump lists :Jump lists give

access to application,

specific documents
and/ortasks.

: These are specific
folders in windows
7 that cat a log
documents, pictures
music, videos, etc.
under a single roof,
regardless of where
we actually store
them on our hard
drive.

iv) One-click Wi-Fi : Windows 7 makes
choosing a
wireless network
to cannot, simple
an consentient.

v)  Windowssearching:In windows 7, we
may find documents,
songs and email
messages etc. in a
faster way.

iii) Libraries

vi) You can arrange windows side by side
on the desktop using shop.

When we compair windows7 with a touch
screen PC, we may browse online
newspapers, flick through photo albums and
shuffle files and holders first by using our
fingers.

Windows Touch present only in the Home
premium, professional and ultimate editions.

Lab Activity:
Doityourself

Chapter-3 More about Ms Word 2007

Oral SKkills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick (v)the correct option:
iii) Ribbon b) i) insert
i)  three
3. Fillin the blanks:
repeated b) Next c) ESC
Dialog
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Answer the following question:

a)

b)

d)

Two main components needed in a mail

merging process are:

i)  Maindocument.

i1)  Datasource.

Mail merge is a feature in Msword which is

used to send same letter to a number of

people.

Hyperlink assist you to move instantly from

one page to another page by just clicking a

link. The link can be in the form of text or

picture.

To follow a link point your mouse to the

hyperlink text. Your see a message " Ctrl +

click to follow link" press Ctrl Key and click

on the link.

To replace word Teacher with my teacher,

follow the steps given below.

i)  Click the home tab.

i1)  Click Replace from editing group. The
Find and Replace dialog box comes up.

ii1)) In the Find what box, write the text you
want to search fori.e., Teacher.

iv) In the Replace with box write the text
you desire to be replaced with i.e., My
Teacher.

v)  Click more button to get more search
options.

vi) Select the needed search options to

filter your search and also select

direction of search. Close the dialog box
when you have completed your work.

Click Replace to replace the present

word. If your see the Replace All

option, it will replace all the
occurrences of the word Teacher with

My Teacher.

To replace text with some alternative text,

follow the given steps below.

1)  Click the Home tab.

i1)  Click Replace from editing group. The
find and replace dialog box comes up.

ii1) In the find what box, write the text you
want to search for.

Vvii)

iv) In the Replace with box write the text
you desired to be replaced with.

v)  Click more button to get more search
options.

vi) Select the needed search options to
filter your search and also select
direction of search. Close the dialog box
when you have completed your work.
Click Replace to replace the present
word. If you use the Replace all option,
it will replace all the occurrences of the
word 'class' with 'Grade'.

vii)

Lab Activity:
Do ityourself

Chapter-4 Applications of MS Excel 2007

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥)the correct option:
a) i) Charts b) iii)) Computerised
c) 1) Office d) 1iii) Buttons
3. Fillin the blanks:
a) Audio b)  Various
c¢) Recording d) Source
4. Answer the following question:
< a) Inan Excel 2007 worksheet the cell with the
black outline is active cell, data is always entered
into this active cell.

b) Columns run vertically on a worksheet and
each one is identified by a letter in teh column
header.

c) The Formula bar is located above the
worksheet.

d) Row'srun horizontally in a worksheet and are
identified by such as A1, F4, a number in the
row header.

e) There are four types of data entered in a

worksheet.

1. Labels :Any text entry is called
labels like name, address,
etc.

2. Values :Any numerical data is
called values like roll no,
marks etc.

: It can be represented in

short date format or long

3. Date



date format. Example
23/11/1986 or November
21,1986.

4. Formula:It is a mathermatical
calculation like, addition,
subtraction, multiplication.
Formula starts with '='sign.

f)  Toenter dataina worksheet, the steps are:

1. Click on the cell or place the cursor in
the cell in which data is to be entered
and type data.

2. Press Enter key or click on M button in
the formula a bar to insert data in the
cell. To cancel the data, while typing,
press ESC Key or click on Xl button in
the formula bar.

Lab Activity:
Doityourself

Model Test Paper - 1

1. Tick(¥)the correct option:

a) 1) Five b) 1) Age

c) ii) Audio d) 1) Automatically

e) iii) Ribbon f) 1) Office

g) i) Nods

2. Fillin the blanks with correctinformation:

a) Tired b) Set c) First

d) e) Next f) Dialog

g) Audio h) Various

3. Answer the following questions:
a) Two features of first generation computer
are:
1)  Theyuse vacuum tubes.
ii) They were expensive.

b) Ripping : The process of copying songs
from audio CD to our computer
in windows media player is
called ripping. During ripping
process, the player makes a
copy of every songs. Stores it
on our hard disk as a window
media Audio (WMA). MP3, or
WAV file, and then adds it to our
player Library.

Burning : To burna CD is to copy data

from our computer to a CD. To
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d)

do this, we should have a CD
burner / writer linked to or
installed in our computer. We
may use either a blank CD-Ror
CD-Rw disc for burning the
Cds, but not all CD players can
play CD-Rwdiscs.

1)  Sheet down means to turn off your
computer.

i1) Sleep is a power saving state that
permits a computer to instantly resume
full-power operation in seconds.

ii1) Hibernation is a power-saving state
developed primarily for laptops while
sleep mode put our work and setting in
memory and draws a small amount of
power, hibernation mode puts then
turns off our computer.

Hyperlink assist you to move instantly from

one page to another page by just clicking a

link. The link can be in the form of text or

picture.

To replace text with some alternative text,

follow the given steps below.

1)  Click the Home tab.

i1)  Click Replace from editing group. The
find and replace dialog box comes up.

ii1) In the find what box, write the text you
want to search for.

iv) In the Replace with box write the text
you desired to be replaced with.

v) Click more button to get more search
options.

vi) Select the needed search options to
filter your search and also select
direction of search. Close the dialog box
when you have completed your work.

vii) Click Replace to replace the present
word. If you use the Replace all option,
it will replace all the occurrences of the
word 'class' with 'Grade'.

To apply custom Animation, follow the given
steps below.

1. Choose the object on the slide that you
want to animate. For instances the
placeholder.



2. Click the Animation tab.

3. Click custom Animation from
animations group. The custom
Animation task pane comes up on the
right hand side.

4.  Click the add effect button. You see a
list with four options. Now select one to
the following.
< If you want to make the object

enter the slide show presentation
with an effect, click Entrance and
then select an effect.
< If you want to add an effect to an
object, that is on the side, Click
emphasis and then select an effect.
< If you want to add an object that
makes if leave the slide at some
point, to click Exit and then select
an effect.
< If you want to add an effect that
makes an object move in a specified
pattern apply the option potion
paths to specify the pattern.
5. Click play button to preview your slide.

Chapter-5 Formula in MS Excel 2007

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥) the correct option:
a) 1) Available b) 1) Mathematical
c) 1) Ampersand d) 1) 8192
3. Fillin the blanks:
a) Calculations b) Two
c) Relational d) Errors
4. Answer the following question:

a) Differences between Arithmetic, Relational
Logical Operators.
Arithmetic Operators :
Arithmetic Operators are applied to the type
of calculations with numeric values. They
cannot be applied with strings.
Relational Operators: Relational operators
are applied to comp are two values. They
form relational expressions. These operators

always produce a single value as output: True
or False.

Logical Operators :Logical operators
are applied to compare two or more relational
expressions. These operators also always
produce single value us output: True of False

b) Arranging a given set of data according to a
specific order (ascending or descending) is
known as sorting.

c) Max () function is used to calculate
maximum values. and Min () function is used
to calculate minimum values.

d) Let's learn simple formulas using the
arithmetic operators.

There should be some arithmetic operator to
operate on date or numbers.

The data may be a cell address also.

Look at some valid formulas in MS Excel
=20+30%*5 =A2+B2 =C5*15

e) Tosortdata, follow the steps given below:

1. Selectthe cells with the data to sort.

2. Click the data tab on the Ribbon.

3. Clicksortinsort & Filter group.

4.  Choose options you want for instance,
Total marks in sort by, values in sort on.
Largest to smallest in order.

5. Click the ok button.

f) The errors generated while doing
calculations are:

Hit#H : The column is not wide enough

to display the number.

#DIV/1 : The formula contains an invalid

operation.

#N/A  : Divisionbyzeroissaid onin

Lab Activity:
Do ityourself

Chapter-6 More About MS PowerPoint 2007
Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥)the correct option:

a)
c)

Saved
i1) Design

i) Right b) i)
i) Edit d)



Fillin the blanks:

a)
c)

Attractive
Ms office scuf

Three b)
Music d)

Answer the following question:

a)

b)

To apply custom Animation, follow the given

steps below.

1. Choose the object on the slide that you
want to animate. For instances the
placeholder.

2. Click the Animation tab.

3. Click custom Animation from
animations group. The custom
Animation task pane comes up on the
right hand side.

4.  Click the add effect button. You see a
list with four options. Now select one to
the following.
< If you want to make the object

enter the slide show presentation
with an effect, click Entrance and
then select an effect.
< If you want to add an effect to an
object, that is on the side, Click
emphasis and then select an effect.
< If you want to add an object that
makes if leave the slide at some
point, to click Exit and then select
an effect.
< If you want to add an effect that
makes an object move in a specified
pattern apply the option potion
paths to specify the pattern.

5. Click play button to preview your slide.

A theme is set of fonts, colours and special

effects. Theme gives attractive background

to your slides.

To use a theme on chosen slides follow the

steps given below.

1. Click the slides tab at the left side of the
window.

2. Hold downthe CTRL key and then click
to cheese the slides on which you want
to use a theme.

3. Click the Design tab on the Ribbon.

4.  Click more button in the Themes group.

5. Right click on the needed theme and

click Apply to selected slides.

c) Stepstoinsertatable onaslide.

I. Cheese any slide layout that
incorporates a table place holder. For
instance content & title.

2. Click on the Table placeholder. The
Insert table dialog box comes up.

3. Enter the number of columns and rows.
Click ok button.

4. Anempty table appears. Fill in the data
to complete your table.

d) Resizing picture helps us to place picture in
any direction as we want.

To resize a picture, click on any of the blanks

circles that look around the picture when you

selectit. Now, dray it in the desired direction.
Lab Activity:
Doityourself
Chapter-7 Log on To Flash

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick (¥) the correct option:

a) 1) Fixed b) i) Panel

c) 1iii) Circular d) 1) Square
3. Fillin the blanks:

a) Rectangular b) 500 x400

c) Commands d) Quality
4. Answer the following question:

a) Polystar Tool is used to make polygon and
star figures.

b) Key frames are special kinds of frames where
you can attribute some conversion such as
color, position, shape etc.

c) Erase mode modifiers are used to erase lines

i

and fills of an object from the stage. It's

options are:

Eraser Normal : Erase all lines and fills
wherever the eraser is

moved.
Erase Fills : Only erases the fill colours
while lines are unelected.
EraseLines  : It is applied to erase the

strokes only.



Eraseselected Fills : Assists in erasing a 4. Answer the following question:

selected part of the a)
object.
EraseInside : Erases the internal part of
an object.

d) Pencil Tool contains three various modes :
Straighten, Smooth and Ink.

Straighten : Its default option is straighten.
Straighten mode straightens
the line automatically drawn b)
by the pencil Tool.

Smooth  : Smooth mode Smoothens the
jerks on the edges.

Ink : Ink mode assists in freehand
with no modifications.

e) Rectangle tool is used to make a rounded c)
rectangle. Select the Rectangle Tool. Hold
and drag the mouse pointer on the stage. As
the rectangular shape is made, release the left
mouse button. To make the rounded rectangle
select set corner Radius too from the options
section. The Rectangle settings dialog box
comes up. Enter any number from 0 to 99 in
the corner radius box. Click ok. Now make a
rectangle on the stage. You will see arounded
rectangle with the Particular corner settings.

f)  Differences between line tool, pen tool and 9

pencil tools are—

i)  Linetoolisused to make straight line.

i1)  Pen tool is used to make precise paths

such as smooth flowing curves.
Lab Activity:
Do ityourself
Chapter-8 Introduction to QBASIC

Oral Skills
1. Doityourself e)
Writing Skills

Multiple Choice Questions:
2. Tick (v) the correct option:

a) ii) Symbols b) 1iii) Mathematical
c) i) String d) 1) Dollar($)
3. Fillin the blanks:
a) Program b) Toprint
c) End d) Change

To save a program in QBASIC,

Click on teh File menu and select Save As

Option. Type a meaningful name for your

program in 'File Name' text box and press the

Enter Key. Your file will be save with the

name typed by you and extension. BAS, will

be added automatically to it. The file name

should never exceed more than 8 characters.

A variable is a location in memory to which

any value can be mentioned. It continues to

keep the value until another value is given to

it. There are two types of variables .

1)  Numeric variables

i1)  Alphanumeric or string variables.

Follow the steps given below to write a

program in QBasic.

1. Double click on the QBASIC icon to
star QBASIC.

2. The QBASIC window will appear up
with a welcome dialog box.

3. Press the ESC Key to hide the welcome
dialog box.

4.  The first window of QBASIC comes up.

5. Typethe program.

Hierarchy defines the order in which the

operators are carried out in any Basic

expression. We use BEDMAS for the

hierarchy of operation. The full form of

BEDMAS is

—  Brackets()

—  Exponentiation "

—  Division

—  Multiplication

— Addition

—  Subtraction

The main features of a computer are:

©vn»zZomw

Accuracy:-

A computer is a very speedy and accurate
machine. It never does any mistake while
calculating. When the input data and the set
of instructions are correct, the output
produced is accurate.

Speed:-

A computer is an extremely fast machine. It
carries out very complicated calculations in



few seconds that a human would do in several
years.

Diligences:-

A computer works continuously and
tirelessly for a very long time unlike human
beings, it never becomes bored. When ten
million of calculations are to be carried out a
computer performs the ten millionth
calculation perfectly with the same speed and

4.

Answer the following question:

a) To create an e-mail ID in www.gmail.com,

follow the given steps below.

1. Make sure that you are connected to the

internet. Open any web browser.

2. Type www.gmail.com in the address
bar and press the enter key. The home

page of www.gmail.com comes up.

accuracy as if carried out the first one.
High Memory:-

A computer has a very good memory. It stores
very good amount of data in its memory and

exactly retrieves them whenever needed.
Versatility:-

A computer performs a number of various
tasks. One moment, it prepares the outcome
of a specific examination. The next moment,
itbecomes busy solving sums and throughout

itmay be used to listen to songs also.

f)  Differences between third generation and

fourteen generation computers.
Third generation computers

< They used electronic devices known as

Integrated circuits.

the second generation computers.
Fourth generation computers

< They were more accurate and faster than

< They used a device known as

MiCroprocessor.

7

< They more extremely easy to handle.

Lab Activity:
Do ityourself

Chapter-9 More About E-mail & Internet

Oral SKkills

1. Doityourself

Writing Skills

Multiple Choice Questions:

2. Tick (v) the correct option:
a) iii) Bin b) 1) Forward
c) 1) Mandatory d) 1iii) Electronic

3. Fillin the blanks:
a) Effective b) Domainname
c) File d) Received

3. Look for the log in button and click on
it.

4.  Type in the desired account name in the
Desired Login Name box. If the account
name you have entered is already used
by someone also, you receive a message
along with a list of suggestions.

5. Fill all the entries correctly and click the
Next stop button to submit your e-mail

account.

6.  Click continue to Gmail to open your e-
mail account window.

b. To access your e-mail account, you are
required to log in or sigh in.

1. Open the website in which you have
created your account. In our case, it is
www.gmail.com.

2. Enter your login name or username and
password in appropriate boxes.

3. Click on sign in button. Your account
window comes up.

c) Stepstocompose mail

1. Click on compose button. The compose
window comes up.

2.  Enter the address up the receiver's mail
id in To area. If you desire to send a copy
of the same message to some other
persons, enter their e-mail address in
CC (Carbon Copy) area. If you desire to
send the same message to other persons
without letting them know about the
fact that others also have received the
same message, type their addresses in
BSS (Blind Carbon Copy) area.

3. Enter subject of the mail in the subject
area.

4. Type the contents of your message in
the space given.



5. Click on the send button.

d.  After completing your task, never forget to
sign out from your account, or else other
people can access your account.

To sign out, click the link available on the
webpage.

Lab Activity:
Doityourself

Model Test Paper - 11
Tick (v') the correct option:

a) 1) Available b) 1) Ampersand
c) 1) Saved d) 1ii) Design

e) 1) Square f) i) Symbols
g) i) Dollar($)

Fill in the blanks with correctinformation:

a) Relational b) Calculation

c) Attractive d) MSoffice

e) Operations f)  Rectangular
g) Toprint h) Change

Answer the following questions:
a) Differences between Arithmetic, Relational
Logical Operators.
Arithmetic Operators :
Arithmetic Operators are applied to the type
of calculations with numeric values. They
cannot be applied with strings.
Relational Operators: Relational operators
are applied to comp are two values. They
form relational expressions. These operators
always produce a single value as output: True
or False.
Logical Operators :Logical operators
are applied to compare two or more relational
expressions. These operators also always
produce single value us output: True of False
b) Tosortdata, follow the steps given below:
1. Selectthe cells with the data to sort.
2.  Click the data tab on the Ribbon.
3.  Clicksortin sort & Filter group.
4.  Choose options you want for instance,
Total marks in sort by, values in sort on.
Largest to smallest in order.
5. Click the ok button.
c) Resizing picture helps us to place picture in
any direction as we want.

d)

b)

b)

To resize a picture, click on any of the blanks
circles that look around the picture when you
selectit. Now, dray it in the desired direction.
A theme is set of fonts, colours and special
effects. Theme gives attractive background
to your slides.

To use a theme on chosen slides follow the

steps given below.

1. Click the slides tab at the left side of the
window.

2. Hold downthe CTRL key and then click
to cheese the slides on which you want
to use a theme.

3. Click the Design tab on the Ribbon.

4.  Click more button in the Themes group.

5. Right click on the needed theme and
click Apply to selected slides.

Key frames are special kinds of frames where

you can attribute some conversion such as

color, position, shape etc.

Differences between line tool, pen tool and

pencil tools are—

1)  Linetool isused to make straight line.

i1) Pen tool is used to make precise paths
such as smooth flowing curves.

A variable is a location in memory to which

any value can be mentioned. It continues to

keep the value until another value is given to

it. There are two types of variables .

1)  Numeric variables

ii)  Alphanumeric or string variables.

Differences between third generation and

fourteen generation computers.

Third generation computers

< They used electronic devices known as

Integrated circuits.

< They were more accurate and faster than

the second generation computers.

Fourth generation computers

< They used a device known as

Mmicroprocessor.
< They more extremely easy to handle.



